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Opening Notes 

 

Open-source tools for various types of work, are constantly expanding. Herein, I 

provide a tutorial of QGIS (www.qgis.org), which is capable of almost any GIS operation 

I’ve ever needed, either on its own, or using the various plugins and associated tools. 

QGIS installs and directly links with other programs including SAGA GIS and GRASS 

GIS, allowing users to take advantage of cooperation among the free and open source 

software developers. Furthermore, data can be exported to a variety of formats, for use 

in other programs. 

My goal here is to provide a basic skill-set to the new GIS/QGIS user, so they may 

navigate the software for their own work, and further explore its capabilities. This 

tutorial is by no-means comprehensive. I suggest users browse and search the QGIS 

documentation (https://qgis.org/en/docs/index.html) when they are stuck, or make use 

of relevant support channels (https://qgis.org/en/site/forusers/support.html). 

Furthermore, a lot of examples are given here without going into intricacies of analysis. 

Thus, I suggest before quantitative analytics, users read further on the tools/analyses 

that can be employed. 

http://www.qgis.org/
https://qgis.org/en/docs/index.html
https://qgis.org/en/site/forusers/support.html
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Installing QGIS 

I generally recommend working with the most recent version of QGIS available, with the 

most recent features, or the most recent Long Term Release, which is designed to be 

maintained with bug-fixes and such for the next three release cycles. Long term releases 

might not have the most newest features found in the most recent version, but focus is 

broader stability across time. At the time of writing, the most recent version is 3.0.2; the 

long-term release is 2.18.9. Everything presented herein was tested using QGIS 3.0.2, 64 

bit, on Windows 10. Though there have been some changes since 2.18.x, the general 

workflows will be consistent. (Releases are denoted as x.y.z, where changes in ‘x’ denotes 

some potentially larger changes in the software, changes in ‘y’ denote additions of 

features and bug fixes, and changes in ‘z’ generally reflect bug-fixes.) 

 

For Windows users: 

Download and run the standalone installer, available here: 

https://qgis.org/en/site/forusers/download.html (QGIS Standalone Installer Version 

3.0.2 will be sufficient; the OSGeo4W installer gives more advanced options, but is not 

needed). 

• When it gives you the option, you do not need to download the sample datasets, 

although feel free to and use them for other tutorials or examples. 

 

For Mac OS users: 

Download files should be available on the main QGIS download page. (At time of 

writing, when clicking to expand the box for “MacOS” from a non-Mac computer, the 

https://qgis.org/en/site/forusers/download.html
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page scrolls to the bottom; if this happens, users should scroll up to find the download 

links!) 

 

For Linux Users:  

Follow instructions provided here: 

https://qgis.org/en/site/forusers/alldownloads.html#linux.  

 

Installing Plugins 

One of the strengths of QGIS is the availability of capable plugins that have been written 

for it. 

• To see what plugins are installed, open QGIS by double-clicking on the “QGIS 

Desktop” icon on your desktop or in your start menu.  

• Then, click the Plugins menu at the top of the main QGIS window, and navigate 

to “Manage and Install Plugins”.  

• When the Plugins window opens, search for the following plugins and install 

them if they are not indicated as already installed (having a checked- or 

unchecked-box to the left of the name; uninstalled plugins will have a puzzle 

piece emblem next to the name):  

o QuickMapServices 

o Processing (installed by default) 

• To ensure these plugins are active, make sure the box next to the name has a 

check-mark in it. 

 

https://qgis.org/en/site/forusers/alldownloads.html#linux


 

6 

Data Sources Used in this Tutorial 

The data sources used in this tutorial are available for download in a single .zip folder, at 

the URL where you accessed this document. Individual data layers and original sources 

are listed below. Please see the URLs for the original sources or the included metadata 

for individual layers for more detail. Throughout the document, I primarily refer to 

layers with the italicized names given below. 

 

Text Delimited Table 

• Copperhead Data  – “Brazos County A contortrix_TxCentral.csv” – Specimen 

locations for copperheads, Agkistrodon contortrix, in Brazos County, Texas, 

provided by the Biodiversity Research and Teaching Collections at Texas A&M 

University (https://brtc.tamu.edu/). Most localities were definitely collected in 

the WGS84 datum; the others are assumed to be for this tutorial. 

 

Vector Data (Shapefiles) 

The following layers for Brazos County and the city of College Station, TX were accessed 

from the City of College Station GIS Department in 2014 (newer files may be available 

at: http://www.cstx.gov/index.aspx?page=3683). 

1) County Boundary – Brazos_County_Boundary_8-20-02.shp (in 

/CountyBoundary) 

2) City Limits – City_Limits.shp (in /CityBoundary) 

3) Rivers and Streams – Rivers_and_Streams.shp (in: /RiversStreams”) 

 

https://brtc.tamu.edu/
http://www.cstx.gov/index.aspx?page=3683
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Raster Data 

The raster dataset used in this tutorial is the 1 Arc-second (~30m) Digital Elevation 

Model from the U.S. Geological Survey 

• DEM – imgn31w097_1.img (in /DEM 1ArcSec)  

 

Get to Know QGIS 

Open QGIS on your computer using the QGIS Desktop icon in your Start Menu or 

Desktop. 

• By default, only one pane is likely open – the “Layers/Browser” pane on the left 

side. You can adjust what is open by going to the “View” menu from the toolbar, 

and mouse-over “Panels”, and see different options. 

• Explore icons by hovering over them with the mouse; click on menu-bar items to 

explore the drop-down menus. 

• To save the project click the “Save” icon and designate a file location. When you 

re-open a project, any layers that you were using should be in the same 

locations on your computer; if they are not, you will need to re-designate the 

appropriate file paths. If you transfer data and a project file to another 

computer, keep the files in the same locations relative to one another and the 

project should open without a problem. Make sure to periodically save the 

project as you work. In the latest versions, QGIS automatically shows the most 

recent projects. You can simply click a desired project to return to it, or otherwise 

navigate through QGIS to proceed with a new project. 
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Opening Files (General) 

Starting with version 3.0.0, QGIS has a universal Data Source Manager that facilitates 

opening myriad types of files from a central interface. The icon, pictured at left, should 

be the top-most on the left side of the screen. Users can also access it via “CTRL + L” (on 

Windows) or going to “Layer” on the toolbar at the top and finding it. As with earlier 

versions of QGIS, users can still go to “Layer” -> [Desired Layer Type] to load specific 

types of data, and this will call the Data Source Manager with the appropriate tab. 

 

Many common spatial data formats can also be opened by going to the “Browser” pane, 

navigating to the file location, and clicking/dragging the file into the general view or into 

the “Layers” pane. 

 

Open Shapefiles,  

Shapefiles (.shp extension) are one file format of vector data (points/lines/polygons) 

commonly used in GIS. Though these are largely replaced by files within ESRI File 

Geodatabases (.gdb extension) in ESRI products and Geopackage (.gpkg extension) in 

QGIS, a lot of datasets are still distributed as shapefiles. 

• Within the Data Source Manager, click the “Vector” tab on the left (Or use 

“Layer” menu from the toolbar and navigate to “Add Layer” -> “Add Vector 

Layer”) 

o Set the Source Type to “File” and Encoding to “System”. 

o Click “Browse” and navigate to the appropriate files, using the appropriate 

file types (for Shapefiles, set to “ESRI Shapefiles [OGR] (*.shp)”). 



 

9 

o Select County Boundary, City Limits, and Rivers and Stream layers 

respectively, and click the “Add” button. 

**Note –To access data from ESRI Geodatabase (.gdb files; not used in 

this exercise), set “Source Type” to “Directory”, and navigate to .gdb files. 

• Adjust the layer order by clicking and dragging layers up and down in the 

“Layers” pane. 

o Put Rivers and Streams on top, then City Limits, and County Boundary 

• To adjust layer symbology (how the data appear): 

o Right click on individual layers and select “Properties” (or Double Click on 

the layer) 

o Select “Style” on the left; click on a symbol in the “Symbol Layers” box, 

and customize to your liking.  

▪ You can also open a “Layer Styling” panel via “View” on the 

toolbar -> “Panels” -> “Layer Styling” 

• To view the tabular data associated with a layer, right click on the layer and select 

“Open Attribute Table”. 

• To view information about a layer at a specific point in space, click on the 

“Identify Features” icon on the tool bar, and click on the point of interest. The 

default setting show information about the layer highlighted in the “Layers” pane. 

 

Open Delimited Text Layer (e.g., points based on a table with Coordinates) 

• In the Data Source Manager “Add Delimited Text Layer” icon. (See example 

dialogue box on next page.) 
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o Navigate to the appropriate file (Copperhead Data; “Brazos County_A 

contortrix.csv”) 

o Expand the “File Format” section and select the appropriate text delimiter 

(comma for this file). 

o Expand the “Records and Fields” section – if the first line contains field 

names (column names) as in this case, make sure the “First record has 

field names” box is checked. 

o Expand the “Geometry Definition” section (typically “Point Coordinates”), 

and identify fields for X and Y coordinates (e.g., Longitude and Latitude, 

respectively). 

o If the data are based on a geographic projection Decimal Degrees are 

expected as with the Copperhead data; if data are as Degrees Minutes 

Seconds, check the “DMS Coordinates” box. 

▪ By default, the CRS (Coordinate Reference System) for the new 

layer is set to the CRS of the project, Lat/Long, WGS84 (EPSG 

4326). You can change the CRS of the layer by clicking on the globe 

icon, though that is not needed in this case. 

o Click “Add” 

o The layer should now appear in “Layers” pane. You can adjust the 

symbology by editing the properties as described above. 
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Add a Background Layer 

When we import spatial data, we often like to visualize them over some sort of 

background layer, such as aerial imagery, or a simple map. This allows us to identify if 

layers are being displayed in approximately the right location, and it can help with some 

preliminary interpretation of data. For this exercise, we will utilize the 

QuickMapServices Plugin. 

• Click on “Web” from the menu bar at top, navigate to “QuickMapServices Plugin” 

-> “Search QMS”; the search panel for this plugin will appear. 

• By default, some Google layers will be available to load. If you click “Add” while 

selecting any specific layer, the newly added background layers will appear as the 

bottom-most layer.  

o You can also use the Search bar to find map services that are made 

available in this plug-in (e.g., search for Google, Bing, or Open Street 

Map). 

 

Open and Manipulate a Raster Layer 

• In the Data Source Manager click the “Raster” icon  

o Navigate to the desired file; can either specify desired file type or browse 

any of the available types. Browse to the “DEM 1ArcSec” folder and select 

“imgn31w097_1.img”. 

• Change Color Palette to enhance visualization. 

o Right-click on the layer (“imgn31w097_1”) and select “Properties” 

o Click “Style” – There are lots of options to adjust. The below steps just 

serve as an example. (See next page for sample dialogue box). 
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▪ Change “Render Type” to “Singleband pseudocolor” (Avoid multi-

band options unless you are using multi-band imagery (e.g., 

Landsat imagery)) 

▪ Adjust the Min/Max settings as desired. 

• Using the true “Min/Max” (third option) will have the color 

gradient span the entire range of values in the raster dataset. 

▪ Select a color ramp that you like (e.g., the default is ‘viridis’) and 

click “Classify” button to set bins automatically, and click “Apply”. 
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If you like it, click “OK”, if not, adjust as needed. Feel free to try 

adjusting other options too. 

• You can also adjust colors and labels in the editing box to the 

left. 

• You can use “Save Style” and “Load Style” buttons to use a 

standard color ramp across multiple projects or raster layers. 

 

You can use the “Zoom In” tool to zoom in enough to see individual pixels. Select the 

tool from the toolbar, and click and drag a box on the area you wish to zoom to. 

• To measure an individual pixel and make sure it is the size you expect click on the 

“Measure” tool from the toolbar, and select “Measure Line” from the drop-down 

menu. 

o Click at one edge of the pixel, and drag the cursor to the other side; the 

dialogue box will show the measurement based on the units and datum of 

the Project CRS (see Projections [next section]). 
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Projections 

Projection of Layers and Project 

QGIS automatically reads projection information (i.e., the Coordinate Reference System 

[CRS]), if available, from respective layer files. For shapefiles, it relies on the “.prj” file; 

for raster data, it is often embedded in the file. If you load data without built-in 

projection information (e.g., a Delimited Text File), it generally assumes a geographic 

coordinate system (Lat/Long), and uses the World Geodetic Survey 1984 (WGS84) 

datum, or may use the Project CRS the user to specify. It is always a good idea to check 

that the projection information is interpreted correctly by QGIS. 

• To check the CRS, (and set it if it was not automatically detected) right-click on 

layer and select “Set Layer CRS”. 

o If you do this for the Copperhead Data you will see the CRS that selected 

is WGS84 (using Lat/Long coordinates). This is correct – the datum of the 

original data was exactly that, so nothing needs to be changed, although if 

it was incorrect, you could fix that here. 

By default, QGIS uses “Projection on the Fly” – for visualization (but not necessarily 

analysis) of multiple layers in different CRSs, they are automatically transformed to be 

in the same coordinate space. Previous versions of QGIS had a box to check within the 

‘CRS’ tab of Project Properties (Accessed via “File” -> “Project Properties” or by clicking 

on the ‘EPSG: [Current CRS]’ in the bottom left of the screen - ). In newer 

versions of QGIS (3.x.x), you an turn off Projection on the Fly by checking the box for 

“No Projection (or unknown/non-Earth Projection)”, which will project everything on 

cartesian coordinates. If you do this and – click the “Zoom Full” button on the toolbar at 

top, and the map area will zoom out to include all layers. (In this situation, will want to 
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turn off the QuickMapServices layer, and you will a large blank space between very 

small datasets.) 

 

Changing Projections (CRS) 

For many operations it is necessary to have all layers in the same CRS; even if it is not 

necessary, it can help speed-up processing considerably. The DEM has elevation in 

meters, according the layer’s metadata, and it is in a geographic projection (Lat/Long, 

NAD83). However, for computing some derivatives of elevation such as Slope, it is 

helpful to have the horizontal units the same as the units for elevation. Thus, we will 

work in a projection that is also defined in meters, the Albers Equal Area Projection. 

This projection may cause some distortion in shape, but maintains accurate area 

measurements. This is just a demonstration, and in doing your own work, it is 

important to consider how spatial distortions may manifest in different projections.  

The steps for converting the CRS of raster and vector layers are somewhat different. 

Furthermore, when converting the CRS of raster layers, it is important to think about 

how resampling may cause distortion. This will not be covered in depth here, but Mike 

Bostock provides a useful visualization of this: https://bost.ocks.org/mike/example/. 

 

Changing Project CRS 

As aforementioned, we will use the Albers Equal Area Projection, useful for dealing with 

the DEM. Other projections, such as Universal Transverse Mercator could also be used. 

• Navigate to the Project Properties dialogue box. 

https://bost.ocks.org/mike/example/
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o Browse for “North_America_Albers_Equal_Area_Conic” or use the Filter 

box to search for that, and select the appropriate CRS. A standard code 

used for this CRS (the EPSG code) is 102008. 

• Alternatively, right-click on a layer with the desired CRS, and select “Set Project 

CRS from Layer” [not applicable for this project]. 

 

Changing Vector CRS (for a Shapefile or Text-Delimited Layer) 

This process involves creating a new shapefile with the desired CRS.  

• Right-click on layer that you wish to change the CRS of (in this case, select the 

Copperhead Data) and Select “Save As” 

• Set “Format” to “ESRI 

Shapefile” (or GeoPackage, 

as a newer, open-standard 

format). 

• Use the “Save As” box to 

designate an appropriate file 

location and name for the 

resulting shapefile. 

• For the CRS, you can use the 

“Project CRS” (Or use the 

Browse button to navigate to 

the appropriate CRS if 

necessary).  

o Selecting “Layer CRS” retains the original CRS 
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• Check the box for “Add Saved File to Map” 

• Click “OK” (the original layer can then be removed from the map by right clicking 

on it and selecting “remove). 

• Now do this for the remaining shapefiles. 

 

Changing Raster CRS 

As with vector datasets, when reprojecting a raster, a new file is created and added to 

the project 

• Click on the “Raster” toolbar menu -> “Projections” -> “Warp (Reproject)”. 

In the Dialogue box (illustrated on the next page): 

• Designate the input file from the current project 

• The Source CRS can be left blank if it’s correctly assigned already 

• Set the Target SRS to the desired CRS (EPSG 102008). 

• Check the box for “Load into canvas when finished” to bring the final product 

into the current project. 

• Boxes for NoData and Output resolution boxes can be left untouched for default 

settings (e.g., the NoData value will be assigned to a default for the data type; the 

Output resolution will be approximately the same size as the original, but with 

units converted). 

• Select the desired resampling method. 

o For continuous variables, typically want to use something like bilinear or 

cubic spline that interpolates. If it is a categorical variable, nearest 

neighbor (“Near”) is generally appropriate. 
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• Advanced parameters can be untouched for this exercise, though here you will 

find options for changing the data time, and a few other parameters. 

• For this case, users should set a file path for the Reprojected file. 

**Note – This uses a tool called ‘GDAL’ to do the processing, with code that could 

be used in a command line tool (and edited) presented at the bottom of this 

window. Details for this specific operation are given at 

http://www.gdal.org/gdalwarp.html. 

After these reprojections, you can remove the original layers. 

http://www.gdal.org/gdalwarp.html
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Geo-Processing of Data Layers and Associated Tables 

QGIS has a wide variety of built-in processing operations, and with the other included 

programs it has incredible capability and functionality, easily accessible via the 

Processing Toolbox. We will only cover a handful of operations here, but I suggest 

exploring menus, the Processing Toolbox, and plugins to find other operations that you 

need. In QGIS, these operations generally create a new layer rather than simply editing 

the original. All tools directed via toolbar menus should generally be available via the 

(searchable) Processing Panel – search for the tool, and double-click on it to open the 

respective menu. To turn on the Processing Panel, assuming the Processing plug-in is 

activated, click the “Processing” toolbar menu, and select “Toolbox”. 

 

Some Basic Vector Operations 

Clipping (Remove unwanted sections of a layer, based on bounds of another Layer) 

Hypothetically, say we are working on a project that involves streams of the city of 

College Station, but the stream layer that we downloaded was for the entirety of Brazos 

County. Thus, we can clip the Rivers and Streams to the College Station Boundary. 

• Select the Vector menu at the top and navigate to “Geoprocessing Tools” and then 

“Clip” (illustrated on the next page) 

o Input Vector Layer is the layer that you want altered (Rivers and Streams 

[Reprojected to Albers Equal Area]). 

o Clip Layer is the Layer that you are clipping data to (City Limits 

[Reprojected to Albers Equal Area]). 

o Under “Clipped” designate the new file you want to create in the Output 

Shapefile box  
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(e.g., “CS_Rivers_Albers.shp”). 

▪ Note – the default file type is GeoPackage; you will need to scroll 

through file types to select “SHP” for shapefile. 

• Make sure the box next to “Open output file after running the algorithm” is 

checked and click “Run in Background”. 

• Upon completion, view the result and remove the original if it is no-longer 

needed. 

o The result from processing operations such as this are generically named 

upon being brought into the existing project. The layer is easily re-named 

by right-clicking, and selecting “Rename”. 
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Difference Clip (Clip out the inner area of a polygon) 

In another scenario, we may be interested in a geographic area, excluding a core area. 

With the data at hand, perhaps we are interested in something about County Boundary, 

but wish to exclude the area of College Station. This is done through a Difference Clip. 

• Select the Vector menu at the top and navigate to “Geoprocessing Tools” and then 

“Difference”. 

o Input Vector Layer is the layer that you want altered (Brazos County 

Boundary [Reprojected to Albers Equal Area]). 

o Clip Layer is the layer subtracting from the Input Vector Layer (City 

Limits [Reprojected to Albers Equal Area]). 

o Under “Difference” designate the new file you want to create in the Output 

Shapefile box (“BrazosCounty_noCS_Albers.shp”). 

• Make sure the box next to “Open output file after running the algorithm” is 

checked and click “Run in Background”. 

• Upon completion, inspect the result. 
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View and Edit the Attribute Table 

Many times we need to look at the attribute table for a given layer, and sometimes even 

make some edits. 

• To view the attribute table, simply right click on the desired layer and select 

“Open Attribute Table”. Let’s start with the attribute table for the Rivers and 

Streams layer. 

There’s lots of information here that came with the layer. Some things that might be of 

interest for researchers include the Name and the HydroType (what type of stream/river 

each element is). 

 

If you want to look at a single data entry simply select that row by clicking on the 

number to the left of the data, and it will become highlighted on the map. For the stream 

segments, they’re small, so you’ll need to zoom in to see it. While looking at the map, 

select the Rivers and Streams layer by clicking on it in the Layers pane, and then use the 

“Zoom to Selection” icon to focus on the selected stream segment. To zoom out to the 

entire map again, use the “Zoom Full” icon, or click the “Zoom Out” icon and click on 

the map.  

 

To edit the table, you must first enable editing by clicking the “Toggle Editing Mode” 

icon in the toolbar above the table. Then you can edit text, and add/delete rows or 

columns using the icons at the top of the window. You can also do some table 

manipulations by altering the layer properties.  
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Spatial Join 

We can use the spatial relationships among objects in our project to join tables with 

different information. 

 

Go to the “Vector” toolbar menu -> “Data Management Tools” -> “Join attributes by 

location”. (Dialogue box on the next page). 

• The “Target Vector Layer” will be  the layer we wish to add information to (Rivers 

and Streams) 

• The “Join Vector Layer” will be the layer we wish to add information from 

(Brazos County Boundary) 

• For this example, use the default options, but you can set specific geometric 

qualifiers (the default that the two layers “intersect”); and no need in this case to 

save a new layer ,but simply follow the option to “Create a Temporary Layer”. 

• Make sure the box next to “Open output file after running the algorithm” is 

checked and click “Run in Background”. 

• Click “Run in Background” 

• If you open the attribute table for the new stream layer, you will see all of the 

information from County Boundary now associated with the streams. 
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Some Basic Raster Operations 

Both stand-alone and with plugins, QGIS has a set of tools for working with raster data. 

Only a handful are covered here, but I encourage readers to browse menus, plug-ins, 

and documentation to find other operations you may need. Note that there are also 

various image processing tools that are useful for remote sensing work. 

 

Calculate Slope from a DEM 

• Click on the “Raster” toolbar menu -> “Analysis” -> “Slope”. 

• Select the appropriate Input Layer (DEM [Reprojected to Albers Equal Area]). 

o This is a single band layer, so “Band 1” is the only option for Band 

Number”. 

o Ratio of Vertical Units to Horizontal Units can be useful for when the 

coordinate system is in different units from the vertical units. In this case, 

both are in meters, so it can be left as 1. 

o In this case specify a file location for the output. 

o Make sure the box next to “Open output file after running the algorithm” is 

checked and click “Run in Background”. 
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*Note – As with the reprojection of rasters, other raster processing can be done via 

GDAL command line tools, with the code being used given the bottom of this dialogue 

box: http://www.gdal.org/gdaldem.html.. 

http://www.gdal.org/gdaldem.html
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Reclassify Raster 

Many times we need to reclassify values from a raster dataset. In this example, we will 

change continuous data into categorical groups; this may be appropriate if we know 

specific tolerances of a species, and have a relevant raster layer. I find the easiest ways to 

reclassify a dataset are using either the GRASS or SAGA GIS utilities, accessed through 

the Processing Toolbox. Here, we’ll use GRASS GIS (https://grass.osgeo.org/). 

• Open the Processing Toolbox - click the Processing menu, on the menu bar at top, 

and select “Toolbox”. 

• You should now see the “Processing 

Toolbox”. You can simply type in the 

Search box for “reclass” and one of the 

options, under GRASS will be 

“r.reclass”. Double-click on this. 

 

We will reclassify values of the DEM 

(elevation) to indicate that elevations are 

suitable for a hypothetical species (>75 m; set 

to 1), or not suitable (≤ 75 m; set to 0). 

 

You can use the dialogue box on the next page as an example. This will involve chosing 

the appropriate file to reclassify (the DEM in this case), and either designating a file 

with reclassification rules, or writing the reclassification rules in the appropriate box. 

Details for this are available from the GRASS documentation, which can be pulled up via 

the “Help” button (also available for this function at: 

https://grass.osgeo.org/
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https://grass.osgeo.org/grass70/manuals/r.reclass.html ). The min. and max. values for 

a raster can easily be checked by going to the Style options, setting the “Min/Max Value 

Settings” to “Min/Max”, designating the “Statistics extent” as the “Whole Raster”, the 

“Accuracy” as the “Actual (slower)”, clicking “Apply”, and viewing the min/max values. 

• As with most operations, you there are Advanced parameters that can be adjusted 

(not necessary here). 

• The output file can be designated via the box under “Reclassified”. 

• Make sure the box next to “Open output file after running the algorithm” is 

checked and click “Run in Background”. 

 

https://grass.osgeo.org/grass70/manuals/r.reclass.html
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We will now do the same thing for the Slope raster, following the values in the lookup 

table below. (Low slopes, 0-2° are suitable for the hypothetical species; high slopes, >2°, 

are not). Rename and save this new layer appropriately (e.g., Slope_Reclass.tif) 

 

To verify that these reclassified layers are correct, you can bring the respective 

reclassified layer to the top, and use the “Identify Features” tool to inspect the values of 

each raster. Click on the icon in the toolbar, and a new pane should appear (typically on 

the lower left, “Identify Results”). Then click the mouse on a point, and it will by default 

show you the properties (e.g., value or fields) of the layer highlighted in the “Layers” 

pane. You can adjust the “Mode” and “View” options in the pane, to view characteristics 
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of multiple layers at once. (Users can also install the “Value Tool” plug-in, which will 

allow display of raster values wherever the mouse is hovering. 
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Raster Calculator 

Many times we need to create a new raster layer that is based on a composite of other 

layers. For example, in the previous examples we reclassified DEM Albers and Slope 

Albers rasters to identify where elevation and slope are suitable for a hypothetical 

species. We can combine these reclassified layers, mathematically, to identify where 

BOTH elevation and slope are suitable, simply by multiplying overlapping pixels from 

the respective layers. In this resulting raster, areas where a pixel is 0 in either raster will 

be 0 (unsuitable based on both layers); locations where both characteristics are suitable 

will be represented by values of 1. 

• Use the Raster menu on the menu bar and navigate to 

“Raster Calculator”. 

• In the dialogue box that pops up, double-click either 

the DEM Reclass or the Slope Reclass layer to add it to 

the expression box in the bottom. (See next page for an 

example dialogue box.) 

• Click the “*” button to designate the multiply function. 

• Add the other relevant layer to the expression box 

• Designate an output location, set the format, check “Add result to project”, and 

click “OK”. 

After processing, you will see the new layer in the “Layers” pane, and you can explore it 

to ensure the output is as-expected. 
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You can use this tool for various other calculations, using the buttons provided. You can 

also type in the “Raster calculator expression” box at the bottom, to add numeric terms 

and such. 
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Using Vector and Raster Datasets Together 

Clipping a Raster 

When downloading raster layers, they are frequently available for larger areas than 

necessary, which can contribute to additional processing time and decrease available 

memory. To deal with this, we can easily clip the raster to the bounds of a vector dataset 

or to a set of boundaries based on coordinates. 

• Click on the “Raster” menu from the menu bar, navigate to “Extraction” and click 

on “Clip raster by mask layer” to open the relevant dialogue box (shown on the 

next page). 

• Designate a raster as the input file (I will use “SlopeDEM_Reclass”, the result of 

the previous raster calculation). 

• For “Mask layer” select a vector layer that you want to use for the boundaries of 

the new raster layer. We’ll use the City Limits [Reprojected to Albers Equal Area] 

in this exercise. 

• Keep the default boxes checked. 

• Make sure the box next to “Open output file after running the algorithm” is 

checked and click “Run in Background”. 

 

The new layer will appear in the Layers pane and you can inspect as needed.  
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Compute Zonal Statistics for Polygons 

It is often useful to calculate metrics from a raster layer for a vector dataset, for example 

the mean elevation or slope of a polygon. The “Zonal Statistics” tool is great for this, and 

there are other tools (e.g., in SAGA and GRASS) that allow additional flexibility. 

• In the Processing Toolbox panel search for “Zonal statistics” and double-click on 

the first option (under “Raster Analysis” with the QGIS Icon). 

• For “Raster layer”, select the raster that you want to compute statistics from; for 

the “Polygon layer containing the zones”, select the appropriate vector layer. 

We’ll use the DEM and the County Boundary layers, respectively, both 

reprojected. 

• Designate a prefix for the resulting columns (to help remember which raster you 

used) and click “OK”. We will use the default statistics, but these can be selected 

further by clicking on the “. . .” next to the box.  

 

You can view the result by 

opening the attribute table for the 

polygon layer; and you will see 

new columns representing the 

“count” (count of all contained 

pixels”, the “sum” (sum of all 

values for the contained pixels), 

and the “mean” (average of all 

values for the contained pixels). 
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Making a Quality Map 

QGIS works well for making maps, with easily customizable symbology, and a good set 

of tools to develop a layout for print and publication. Here, we will make a basic map of 

the hypothetical habitat suitability raster for the city of College Station, with an inset 

showing where College Station is in Brazos County. We will include standard map 

elements including a scale bar, north arrow, legend, and coordinate grid. I encourage 

you to explore other options and setups for this, or try making one with your own data. 

As with the other features of QGIS, we only have time to highlight a relatively small 

subset of map-making tools. 

• To get started, open the print composer by clicking on icon indicated at left. If 

you were to have an existing layout that you wish to access in the project, click on 

the icon to the right, “Composer Manager”. After clicking the icon to create a new 

layout, you can either designate a new name or allow the program to generate one 

for you. 

 

Setting up for a Map 

Maps that you bring into the composer will be based on what you see in the main QGIS 

window. Let’s go back to that for now and start by visualizing the layers of the City 

Limits, Clipped DEM/Slope Reclass, and Rivers of College Station (from the vector 

clipping exercise). You can order them as you wish, but make sure you can see all 

elements (for the City Limits layer, you can have that on top as long as you adjust the 

transparency or fill so you can see the other layers, and make sure the city boundary is 

obvious). Manipulate the symbology and labels for these layers to your liking, so they 

will appear alright in a map together. See my set-up on the next page. The yellow color 
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represents areas suitable for the hypothetical species, purple represents unsuitable, and 

the blue lines are the rivers and streams. 

 

Think about what types of coordinate you want to show on the borders of the map; they 

have to be the same as used in the Project CRS. Many people like to see the geographic 

coordinates. For this I often work with the Project CRS as WGS84, and use projection 

on-the-fly (you can also specify the CRS for the coordinates within the Composer 

Manager). You may want to be explicit in a caption about what projection you used to 
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conduct any analyses. After setting that, make sure to click the “Zoom Full” button to 

make sure the focal area takes up as much of the viewing area as possible. (You can also 

adjust the viewing scale using the “Scale” adjustment at the 

bottom of the main QGIS screen.)  

Once satisfied with the layout of the main map, we are ready to start putting a final 

layout together. 

• Go back to the Composition window. 

• Right click on the page and select “Page Properties” – you’ll see an “Item 

Properties” box highlight on the right 

• The only thing we’ll change for now is the Paper Size – change to “ANSI A 

(Letter; 8.5x11 in). 
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Putting Everything Together 

Adding the Map of interest to the Layout 

• In the Composition window click the “Add Map” icon, and click and drag a box 

for in the area you would like the main map to occupy. The view from the main 

QGIS window should now appear in that area. 

o You can go to the “Item Properties” tab to adjust the extent displayed and 

such. I simply click the button “Set to Map Canvas Extent” to show the 

same extent as in the main QGIS window. 

▪ By default, the map layout is cached in memory; if you adjust 

anything in the main map, click the “Update Preview” button to 

show the updated version.  

▪ Check the box for “Lock layers for map item”; if you don’t, when you 

create an inset, this map will be altered. 

*Note: the “Item Properties” tab is dynamic, changing with the type of object you have 

selected. 

 

Adding Gridlines and Coordinates 

• In the “Item Properties” tab, expand the section for “Grids” and click the “+” icon 

(creating “Grid 1”), then select/highlight “Grid 1” and click “Modify”. The settings 

I use are described in context on the next pages and the general appearance is 

illustrated below. 

• The Map units will be the same as used in the Project CRS, but could be specified 

in another CRS if desired. Adjust the spacing and offset in the “Interval” and 
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“Offset” boxes. This usually takes some trial ane error to make it aesthetically 

pleasing. 

• While in the “Grid” menu, expand the “Frame” section and change “Frame style” 

to “Zebra”. 

• Expand the “Draw coordinates” section and check the respective box. Adjust 

settings as you see fit. 
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Adding Scale Bar, North Arrow, and Legend 

• For the Scale Bar: click the “Add Scale Bar” icon, and click and drag a box where 

you want the scale bar to be placed. 

o The scale bar will appear in that area with some default settings. You can 

adjust things like the units and appearance in the “Item Properties’ tab, 

which now characterizes the scale bar. 

• For the North Arrow: click the 

“Add Image” icon, and click and 

drag a box where you want the 

north arrow placed. 

o In the “Item Properties” 

tab, expand the section for 

“Search Directories”. The 

default path links to a 

directory that has available 

images included with QGIS. 

You will see a few that work 

as a north arrow; select one 

and click the “Add” button. 

You can rotate it if 

necessary, to match rotation 

of the map if it is not the typical north-to-the-top orientation. 
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• For the Legend: Click the “Add new legend” icon, and click and drag a box where 

you want it to be placed. A default legend will appear in that area; the box will 

automatically resize to accommodate the dimensions. 

o Again, use the “Item Properties” tab to adjust the settings. Most obviously, 

we want to change some of the labels in the legend so they are not simply 

the layer names from our QGIS project. Note that you cannot change the 

symbology here – you must do that in the main QGIS project window. 

▪ Expand the “Legend items” section and uncheck the “Auto Update” 

box. You can add a new layer to the legend, re-arrange the order, 

and rename items. To change the name of an entry, click on the 

legend entry you wish to edit, and click the “Edit” icon and type a 

new name that you prefer. In the example shown below, the City 

Limits entry is being renamed to “College Station Boundary”. For 

editing specific entries for grouped 

legend items (e.g., the legend for 

Habitat Suitability layer), expand 

the group by clicking the “+” icon 

next the highest level item, and 

select the specific item you wish to 

edit before clicking the “Edit” icon. 

▪ You can add and edit a box around the legend by clicking the box 

for, and expanding the “Frame” section. 



 

44 

Adding an Inset 

Now, the map is starting to really look like a map, but one thing that is useful to have is 

an inset that shows where things are in the broader context. To create this, we need to 

again set up our layers as we wish them to appear in the inset. The only layers we really 

need here are the County Boundary and the City Limits. It is best to use a copy of the 

City Limits layer, as it is used on the main map, and editing the original will alter the 

final product when we export it. To duplicate a layer, in the “Layers” pane of the main 

QGIS window, select the layer you want a copy of, right click, and click “Duplicate”. 

• Do as described earlier to create a suitable looking map with the Brazos County 

Boundary and City Limits layers in the main QGIS window. Below is an example 

setup.  

 

 

 

 

 

 

 

 

• In the Composition window, click the “Add new map” icon again, and draw a box 

where you want it to appear. You can edit it, as with the main map, using the 

“Item Properties” tab. Perhaps add a frame to it, to make it stand out and 

delineate it as a separate entity from the rest of the map. You can also add 

gridlines and coodinates as desired. 
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• Again, check the box for “Lock layers for map item”. 

• You can add a label to this using the “Add new label” icon; select it and click and 

drag a box where you would like the text. 

o In the “Item Properties” tab you can edit the text, font characteristics, and 

text box characteristics. 

Final Formatting and Exporting the Map 

We are almost done creating a final, high quality map. Now you can add anything else 

you need. On the next page, you can see my final version; the only other element I have 

added is another label to serve as a title for the map. If you need to move anything 

around, make sure the “select/move” icon is selected, click on the focal element, and 

move or re-size it. You can also add shapes and arrows using the “Add ellipse” and “Add 

arrow” icons. Furthermore, though not included on this map, you can add another text 

box for annotations, with important details like source data, projection information, etc. 

 

Exporting the Map 

From the Composition window you can export the final product to various image 

formats, to an SVG file, or to a PDF file. Simply click on the respective icons from the 

toolbar at top (shown below, in order), designate a file name, location, any other 

specifics you’d like to adjust, and click “OK”. 
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Closing Remarks 

My goal in this tutorial is to give new users a working knowledge of QGIS. 

Although this only covers a handful of the many possible operations, I hope that folks 

who have completed it have sufficient familiarity with QGIS to explore it further on their 

own. If you continue expanding your use of QGIS, you may wish to script your work for 

better reproducibility and documentation. Python is a common language used for 

scripting in QGIS, and you can find more details on the web (e.g., 

https://docs.qgis.org/testing/en/docs/pyqgis_developer_cookbook/intro.html).  

QGIS is constantly being further developed, and I suggest users periodically 

check for updates to the software, as new tools are often implemented, and processing 

and data management protocols are often improved. Since I first started using QGIS, the 

software has become much more user-friendly, tools have become much more 

expansive, bugs have been fixed, and many operations are faster. This is largely thanks 

to sponsors of the project, and many who put their volunteer time into it, and I 

encourage others to contribute when and where possible. 

https://docs.qgis.org/testing/en/docs/pyqgis_developer_cookbook/intro.html

